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Metadata tools Metadata tools ---- OutlineOutline

•• Introduction, broad remarksIntroduction, broad remarks
•• Tools:Tools:

–– Editors  Editors  
–– Databases Databases 
–– Custom toolCustom tool
–– Comparative matrixComparative matrix

•• Metadata standard crosswalksMetadata standard crosswalks



IntroductionIntroduction



On Metadata QualityOn Metadata Quality

No tool can check the No tool can check the 
accuracy of the metadataaccuracy of the metadata



Selecting A ToolSelecting A Tool

Consider Consider ……
•• CostCost
•• Platform Platform 
•• User supportUser support
•• CapabilitiesCapabilities
•• DataData--entry methodentry method
•• Level of complianceLevel of compliance



Metadata Tool MatrixMetadata Tool Matrix
Open Source Open Source 

ProprietaryProprietary
OnOn--lineline

Stand AloneStand Alone
PlatformPlatform

XML SpyXML Spy Home ed      Home ed      -- $0$0
Professional  ~  $1000Professional  ~  $1000
Enterprise      ~ $3000Enterprise      ~ $3000

Stand AloneStand Alone

MorphoMorpho FreeFree Stand AloneStand Alone
OnOn--line*line*

AnyAny

oXygenoXygen Academic $50Academic $50
Professional $200Professional $200

Stand AloneStand Alone AnyAny

Notepad, WordNotepad, Word Stand AloneStand Alone

EmacsEmacs, vi, , vi, …… FreeFree Stand AloneStand Alone Unix              Unix              

DatabasesDatabases SQLsSQLs { $0 { $0 -- $$$}$$$}
Oracle {$50* Oracle {$50* -- $1000+}$1000+}

MSAccessMSAccess

Stand AloneStand Alone
OnOn--lineline

MixedMixed

NBII toolsNBII tools FreeFree Stand AloneStand Alone
OnOn--lineline

MixedMixed



Morpho Morpho –– Editor & Entry toolEditor & Entry tool

Refer to the next talk by Will Refer to the next talk by Will TyburczyTyburczy



XML Editors  XML Editors  ---- XMLSpyXMLSpy



Editors Editors ---- XMLSpyXMLSpy
•• Why an XML editor?Why an XML editor?

–– To create, edit, correct, or simply view XMLTo create, edit, correct, or simply view XML
–– Schema inspectionSchema inspection
–– Schema validationSchema validation

•• Working with XML to create basic EMLWorking with XML to create basic EML
•• Validation of EMLValidation of EML



XMLSpyXMLSpy ---- Schema ViewSchema View



XMLSpyXMLSpy ---- Document ViewDocument View



Top level EML Schema structureTop level EML Schema structure



Understanding  Understanding  XMLSpyXMLSpy diagramsdiagrams

““root root 
elementelement””

<eml><eml>
……

</eml></eml>



XMLSpyXMLSpy ---- DiagramsDiagrams

““optionaloptional””

<eml><eml>
……

<additionalMetadata><additionalMetadata>
……

</additionalMetadata></additionalMetadata>
</eml></eml>



““sequencesequence””

<eml><eml>
<dataset><dataset>

……
</dataset> </dataset> 

<additionalMetadata><additionalMetadata>
……

</additionalMetadata></additionalMetadata>
</eml></eml>

XMLSpyXMLSpy ---- DiagramsDiagrams



““choicechoice””

XMLSpyXMLSpy ---- DiagramsDiagrams

<eml><eml>
<dataset><dataset>

……
</dataset> </dataset> 

<additionalMetadata><additionalMetadata>
……

</additionalMetadata></additionalMetadata>
</eml></eml>



XMLSpyXMLSpy ---- DiagramsDiagrams

<eml><eml>
<dataset><dataset>

……
</dataset> </dataset> 

<additionalMetadata><additionalMetadata>
……

</</additionalMetadataadditionalMetadata>>
<<additionalMetadataadditionalMetadata>>

……
</</additionalMetadataadditionalMetadata>>

</eml></eml>

““cardinalitycardinality””



•• DoubleDouble--click on click on XMLSpyXMLSpy iconicon
•• File File –– NewNew
•• XML DocumentXML Document
•• Schema InstanceSchema Instance
•• C:C:\\emleml--2.0.12.0.1\\eml.xsdeml.xsd
•• EML root elementEML root element

Begin A New EML Begin A New EML 
DocumentDocument



Vestige of an EML Vestige of an EML 
DocumentDocument



ValidationValidation

•• Using Using XMLSpyXMLSpy to check for wellto check for well--formed formed 
XML and Schema validationXML and Schema validation



Validation cont.Validation cont.

•• Using the online validation service at Using the online validation service at 
http://http://knb.ecoinformatics.org/emlparser/index.htmlknb.ecoinformatics.org/emlparser/index.html



XML Editors XML Editors –– oXygenoXygen



Metadata CrosswalksMetadata Crosswalks

EML
Ecological Metadata 

Language

BDP
Biological 

Data Profile

Metadata Crosswalk



NBII Tools NBII Tools –– TKME EditorTKME Editor

Select 
elements 
from list

Enter 
responses in 
window



Metadata Collection toolMetadata Collection tool
Enter data Enter data 
Section by Section by 
SectionSection

Responses can be saved Responses can be saved 
and managed as .dbf filesand managed as .dbf files



MetavistMetavist 2005 2005 –– USDA Forest ServiceUSDA Forest Service

North Central Research StationNorth Central Research Station

http://http://ncrs.fs.fed.us/pubs/viewpub.asp?keyncrs.fs.fed.us/pubs/viewpub.asp?key=2737=2737

File based metadata recordsFile based metadata records

Form entryForm entry

Utilizes xml tags, schema, and Utilizes xml tags, schema, and stylesheetsstylesheets

Supports CSDGM and Biological Data ProfileSupports CSDGM and Biological Data Profile



MetavistMetavist 2005 2005 –– USDA Forest ServiceUSDA Forest Service



MetaScribeMetaScribe –– NOAA Coastal Services CenterNOAA Coastal Services Center

http://http://www.csc.noaa.gov/metadata/metascribewww.csc.noaa.gov/metadata/metascribe//

This software tool takes advantage of the fact that, within This software tool takes advantage of the fact that, within 
a collection of records for a given data type, the records a collection of records for a given data type, the records 
are generally very similar in content, with only a few fields are generally very similar in content, with only a few fields 
or phrases changing from one record to the next. or phrases changing from one record to the next. 
MetaScribeMetaScribe delivers the greatest savings when used to delivers the greatest savings when used to 
create a collection of similar records. create a collection of similar records. 

Think template.Think template.



Many metadata elements Many metadata elements 
are are ““minedmined”” directly from directly from 
data layer properties.data layer properties.



MenusMenus

Metadata ToolsMetadata Tools

The CatalogThe Catalog

StylesheetsStylesheets



ArcCatalog Metadata ToolsArcCatalog Metadata Tools

Start Metadata EditorStart Metadata Editor

Display Metadata Display Metadata 
PropertiesProperties

Update MetadataUpdate Metadata

Import MetadataImport Metadata

Export MetadataExport Metadata

Select Select StylesheetStylesheet



Before you beginBefore you begin

•• In ArcCatalog In ArcCatalog 
Tools>Options>MetadataTools>Options>Metadata

•• Choose Choose FGDC ClassicFGDC Classic as as 
the Default the Default StylesheetStylesheet

•• Uncheck boxes to Uncheck boxes to 
automatically create automatically create 
and update metadataand update metadata

•• Select Select FGDC EditorFGDC Editor as as 
the Metadata Editorthe Metadata Editor



Even more FGDC (Even more FGDC (usgsusgs) Tools) Tools



What is CNS?What is CNS?

•• PrePre--processes metadata recordsprocesses metadata records
•• Formats record based on element namesFormats record based on element names
•• Profile requires configuration fileProfile requires configuration file
•• CNS output can be read by the CNS output can be read by the 

metadata parser or MP toolmetadata parser or MP tool



What is MP?What is MP?

•• Compiler to parse formal metadataCompiler to parse formal metadata
•• Checks syntax against the FGDC Checks syntax against the FGDC 

metadata standard metadata standard 
•• Configuration file for ProfileConfiguration file for Profile
•• Checks structure and values of Checks structure and values of 

elements, not contentelements, not content
•• MP reads ASCII text or FGDC xml files!!MP reads ASCII text or FGDC xml files!!

–– Uses output from CNS programUses output from CNS program



Metadata EditorMetadata Editor

ParserParser
Output F

iles

Output F
iles

ExportExport

Revise ErrorsRevise Errors

CNSCNS

PrePre--Parsing

Parsing



MP outputMP output

•• layername.txtlayername.txt ASCII text fileASCII text file

•• layername.htmllayername.html HTML format for displayHTML format for display

•• layername.sgmllayername.sgml SGML format for searchSGML format for search

•• layername.xmllayername.xml XML format for metadata XML format for metadata 
crosswalk to other applicationscrosswalk to other applications

•• Mperr.txtMperr.txt Metadata Parser error fileMetadata Parser error file



Working withWorking with MP ErrorsMP Errors

1.1. Examine error fileExamine error file

2.2. Note Note ““acceptable errorsacceptable errors”” –– they wonthey won’’t t 
disappeardisappear

3.3. Return to editor to correct errorsReturn to editor to correct errors

4.4. Run MP againRun MP again

5.5. Once your record is errorOnce your record is error--free, it is completefree, it is complete



Notes about MPNotes about MP

•• Use MP as a guide, not a rigid arbiterUse MP as a guide, not a rigid arbiter
–– Note error severity, set priorities for fixesNote error severity, set priorities for fixes
–– Be aware of Be aware of ““acceptable errorsacceptable errors””
–– MP does not check contentMP does not check content

•• Only human beings can author quality Only human beings can author quality 
metadatametadata



http://www.nature.nps.gov/im/units/mwr/gis/metadata/metadata_toohttp://www.nature.nps.gov/im/units/mwr/gis/metadata/metadata_tools.htmls.htm

NPS Metadata Tools for ArcCatalogNPS Metadata Tools for ArcCatalog



SpellcheckingSpellchecking

Select your data set in ArcCatalog and Select your data set in ArcCatalog and 
run run SpellcheckSpellcheck Metadata from the NPS Metadata from the NPS 
Metadata menuMetadata menu



ArcCatalog ArcCatalog 
examines the examines the 
entire entire 
metadata metadata 
record using record using 
the Microsoft the Microsoft 
Word spell Word spell 
checking toolchecking tool

Spelling corrections are written directly to Spelling corrections are written directly to 
the <layer>.xml filethe <layer>.xml file



In ArcCatalog, select your In ArcCatalog, select your 
dataset and click on the dataset and click on the 
Metadata tabMetadata tab

Run MP from the NPS Run MP from the NPS 
Metadata menuMetadata menu

MP in ArcCatalogMP in ArcCatalog



MP SettingsMP Settings

Output Output 
FilesFiles

OnOn--thethe--fly fly 
error reporterror report

Automatic cleanAutomatic clean--up up 
of nonof non--standard standard 
elementselements

Browse to location of Browse to location of 
MP program filesMP program files

Browse to the location Browse to the location 
configuration file for configuration file for 
profiles or extensionsprofiles or extensions

Creates easyCreates easy--toto--read read 
error fileerror file



ESRI XML TagsESRI XML Tags

NonNon--standard metadata standard metadata 
elements generate lots elements generate lots 
of warnings in MPof warnings in MP Stripping ESRI xml tags Stripping ESRI xml tags 

eliminates warningseliminates warnings



MP Error File (html)MP Error File (html)
Errors listed by Errors listed by 

severityseverity

Use line numbers to Use line numbers to 
find elements in find elements in 
<layer>.xml file<layer>.xml file

Use metadata Use metadata 
editor to correct editor to correct 
errorserrors

Run MP againRun MP again

When metadata When metadata 
record is record is ““errorerror--freefree””, , 
output in FGDC txt, output in FGDC txt, 
sgmlsgml, xml, and html , xml, and html 
formatsformats



LinksLinks
•• EcoinformaticsEcoinformatics: : http://www.ecoinformatics.orghttp://www.ecoinformatics.org
•• LTER LTER http://www.lternet.eduhttp://www.lternet.edu
•• Morpho http://Morpho http://knb.ecoinformatics.org/software/morphoknb.ecoinformatics.org/software/morpho//
•• XMLSpyXMLSpy http://http://www.altova.comwww.altova.com
•• oXygenoXygen http://www.oxygenxmleditor.comhttp://www.oxygenxmleditor.com
•• Stylus Studio http://Stylus Studio http://www.stylusstudio.comwww.stylusstudio.com
•• CNS http://CNS http://geology.usgs.govgeology.usgs.gov/tools/metadata//tools/metadata/
•• MP MP http://geology.usgs.gov/tools/metadata/http://geology.usgs.gov/tools/metadata/
•• Err2html http://Err2html http://geology.usgs.govgeology.usgs.gov/tools/metadata//tools/metadata/
•• TKME TKME http://http://geology.usgs.govgeology.usgs.gov/tools/metadata//tools/metadata/
•• MetaScribeMetaScribe http://http://www.csc.noaa.gov/metadata/metascribewww.csc.noaa.gov/metadata/metascribe//
•• MetavistMetavist http://http://ncrs.fs.fed.us/pubs/viewpub.asp?keyncrs.fs.fed.us/pubs/viewpub.asp?key=2737=2737
•• ArcCatalogArcCatalog http://www.esri.com/software/arcgis/about/desktop.htmlhttp://www.esri.com/software/arcgis/about/desktop.html
•• NatlNatl Park Service Tools for Park Service Tools for ArcCatalogArcCatalog

http://www.nature.nps.gov/im/units/mwr/gis/metadata/metadata_toohttp://www.nature.nps.gov/im/units/mwr/gis/metadata/metadata_tools.htmls.htm
•• MySQLMySQL http://www.mysql.comhttp://www.mysql.com
•• Open Source stuff Open Source stuff http://www.freshmeat.nethttp://www.freshmeat.net
•• FGDC metadata online FGDC metadata online validatorvalidator: : http://geohttp://geo--nsdi.er.usgs.gov/validate.phpnsdi.er.usgs.gov/validate.php
•• EML metadata online EML metadata online validatorvalidator: http://: http://knb.ecoinformatics.org/emlparser/index.htmlknb.ecoinformatics.org/emlparser/index.html
•• Mother of all search engines: http://Mother of all search engines: http://www.google.comwww.google.com

http://www.ecoinformatics.org/
http://www.lternet.edu/
http://www.altova.com/
http://www.oxygenxmleditor.com/
http://geology.usgs.gov/tools/metadata/
http://geology.usgs.gov/tools/metadata/
http://www.esri.com/software/arcgis/about/desktop.html
http://www.mysql.com/
http://www.freshmeat.net/
http://geo-nsdi.er.usgs.gov/validate.php


Key peopleKey people
•• Morpho: Sid Morpho: Sid GargGarg sgarg@nceas.ucsb.edusgarg@nceas.ucsb.edu, Matt Jones: , Matt Jones: 

jones@nceas.ucsb.edujones@nceas.ucsb.edu
•• CNS, MP, TKME  CNS, MP, TKME  george_lienkamper@usgs.govgeorge_lienkamper@usgs.gov
•• XMLSpyXMLSpy Basic questions, Mark Basic questions, Mark ServillaServilla, , InigoInigo San Gil, Deep troubles San Gil, Deep troubles 

support@support@altova.comaltova.com
•• oXygenoXygen support@support@oxygenxmleditor.comoxygenxmleditor.com
•• MetavistMetavist http://http://ncrs.fs.fed.us/pubs/viewpub.asp?keyncrs.fs.fed.us/pubs/viewpub.asp?key=2737=2737
•• ArcCatalogArcCatalog

http://www.altova.com/
http://www.oxygenxmleditor.com/


Thanks!Thanks!

Mark Mark ServillaServilla
George George LienkamperLienkamper

Sam Sam RomanelloRomanello



How to use the crosswalkHow to use the crosswalk

•• Within Within XMLspy/oXygenXMLspy/oXygen –– use XSL use XSL 
transformation option transformation option –– follow instructionsfollow instructions

•• Using standalone Using standalone ““xalanxalan”” XSL interpreterXSL interpreter



Using TKME for the Using TKME for the 
Biological Data ProfileBiological Data Profile

•• Editing BDP not supported in ArcCatalogEditing BDP not supported in ArcCatalog
•• TKME is a public domain toolTKME is a public domain tool

–– Fully compliant with CSDGM and BDPFully compliant with CSDGM and BDP
–– Simple interfaceSimple interface
–– Supports Templates through Supports Templates through ““SnippetsSnippets””
–– Developed and supported by Peter Schweitzer Developed and supported by Peter Schweitzer 

of USGSof USGS
•• Contained on yourContained on your workshop CDworkshop CD
•• Available for download: Available for download: 

http://http://geology.usgs.govgeology.usgs.gov/tools/metadata//tools/metadata/



Entering metadata elements into TKMEEntering metadata elements into TKME

Metadata element Metadata element 
names are listed on the names are listed on the 
left side of screen.left side of screen.

Element value is Element value is 
entered on the right entered on the right 
side of screen.side of screen.



Compound ElementsCompound Elements

Compound elements used to structure hierarchy are Compound elements used to structure hierarchy are 
indicated by a grey screen with no data entry.indicated by a grey screen with no data entry.



TKME File MenuTKME File Menu

Open, Save, Save As, Close, and Quit are typical Open, Save, Save As, Close, and Quit are typical 
Windows operations.Windows operations.

Configure Configure –– specify a configuration file that contains specify a configuration file that contains 
information about profiles, extensions, and output formatinformation about profiles, extensions, and output format

Recent Recent –– displays the most recently edited filesdisplays the most recently edited files



TKME Edit MenuTKME Edit Menu

Clear Clear –– removes text belonging to a removes text belonging to a subtreesubtree

Duplicate Duplicate –– makes and places a copy of the current makes and places a copy of the current 
elementelement

Swap Swap –– switches the order of the current switches the order of the current subtreesubtree with with 
the preceding siblingthe preceding sibling

Prune Prune –– deletes all deletes all subtreessubtrees that do not contain textthat do not contain text

Replace Replace –– performs search and replace functionperforms search and replace function

Cut, Copy and Paste are typical Windows Cut, Copy and Paste are typical Windows 
Clipboard operations.Clipboard operations.



TKME View MenuTKME View Menu

All levels All levels –– shows the entire hierarchyshows the entire hierarchy

1 level 1 level –– shows only the sections of the metadata shows only the sections of the metadata 
standardstandard

(2,3) levels (2,3) levels –– shows two or three level below sectionsshows two or three level below sections

Hide/Show Hide/Show –– hides or shows the children of the current hides or shows the children of the current 
elementelement

Wrap Wrap –– turns on wordturns on word--wrap in the value windowwrap in the value window



TKME Add MenuTKME Add Menu

Wherever the cursor is Wherever the cursor is 
placed in the hierarchy, placed in the hierarchy, 
the Add menu displays the Add menu displays 
elements that may be elements that may be 
added at that level.  added at that level.  
Clicking will add the Clicking will add the 
element.  Use Add again element.  Use Add again 
to insert children of the to insert children of the 
new element.new element.

Note: Reporting requirementNote: Reporting requirement



About SnippetsAbout Snippets

•• Snippets are portions of a metadata record Snippets are portions of a metadata record 
that may be copied and reused within a that may be copied and reused within a 
record or in other metadata records:  record or in other metadata records:  Think Think 
TemplatesTemplates

•• For BDP records, snippets are especially For BDP records, snippets are especially 
helpful for managing helpful for managing CitationsCitations

•• See See 
ProgramsPrograms\\USGSUSGS\\toolstools\\docdoc\\opinionopinion\\announceannounce\\snippets.htmlsnippets.html

on CD for more details about snippetson CD for more details about snippets



Saving SnippetsSaving Snippets

Highlight an element Highlight an element 
that heads a section you that heads a section you 
want to save as a want to save as a 
snippetsnippet

Select Select Save as snippetSave as snippet from the from the 
Snippets menuSnippets menu



Storing Storing 
SnippetsSnippets

Snippets are stored as text files in a Snippets are stored as text files in a \\snippets directory in snippets directory in 
the USGS folder that contains the TKME program.  Folders the USGS folder that contains the TKME program.  Folders 
may be created in may be created in \\snippets to help organize snippet files.  snippets to help organize snippet files.  
Name snippets without extensions.Name snippets without extensions.



Placing Placing 
SnippetsSnippets

Select a parent Select a parent 
element where the element where the 
snippet will be snippet will be 
insertedinserted

Choose a snippet from the Snippets Choose a snippet from the Snippets 
menu and the elements will be placed in menu and the elements will be placed in 
the metadata recordthe metadata record



Highlight a metadata element and choose Highlight a metadata element and choose 
Element from the Help menu.  An entry from Element from the Help menu.  An entry from 
the FGDC workbook will be displayedthe FGDC workbook will be displayed

TKME Help TKME Help 
Menu Menu -- ElementElement



TKME MenuTKME Menu--
OutputOutput

View the current status of your metadata View the current status of your metadata 
record by selecting Output from the Help record by selecting Output from the Help 
menumenu



Exercise Exercise -- Metadata VerificationMetadata Verification

•• Select your data set in ArcCatalogSelect your data set in ArcCatalog
–– Select the metadata tabSelect the metadata tab

•• Run Run SpellcheckSpellcheck from the NPS Metadata from the NPS Metadata 
menumenu

•• Run MP from the NPS Metadata menuRun MP from the NPS Metadata menu
–– Choose MP optionsChoose MP options

•• Examine the Error FileExamine the Error File
•• Revise and run MP againRevise and run MP again
•• Save your metadata output files to C:Save your metadata output files to C:\\temp temp 

or to a floppy diskor to a floppy disk
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